Creating beautiful presentations

Ryan Johnson

With special thanks to:
Natassa Ailamaki, CMU CALCM lab, Markus Püschel
Creating beautiful presentations

Ryan Johnson

With special thanks to:
Natassa Ailamaki, CMU CALCM lab, Markus Püschel

Spacing

Alignment

Contrast

Consistency
Creating beautiful presentations

Ryan Johnson

With special thanks to:
Natassa Ailamaki, CMU CALCM lab, Markus Püschel

Alignment

Contrast

Spacing

Meta: Layering

Consistency

Does this stuff really make a difference?
Creating Beautiful Presentations
Ryan Johnson

With special thanks to:
Natassa Ailamaki, CMU CALCM lab, Markus Püschel
Why do we Care about Presentations?

- In contrast to a paper or other technical writing, you present your work and yourself.
- People remember good presentations:
  - Good content
  - Well presented
  - Well-designed slides
- Many of my colleagues and I put a lot of effort into each presentation, and at the beginning of a career it’s even more important.

What’s wrong here?

This slide (and all others with red headings) by Markus Püschel
Why do we Care about Presentations?

- In contrast to a paper or other technical writing, you present your work and yourself.
- People remember good presentations:
  - Good content
  - Well presented
  - Well-designed slides
- Many of my colleagues and I put a lot of effort into each presentation, and at the beginning of a career it’s even more important

Random (and bad) placement of text:
Looks messy

What’s wrong here?

Not enough spacing:
Hard to read

Contrast should be improved

Contrast could be improved
Why do we Care about Presentations?

■ In contrast to a paper or other technical writing, you present *your work and yourself*

■ People *remember* good presentations:
  ▪ Good content
  ▪ Well presented
  ▪ Well-designed slides

■ Many of my colleagues and I *put a lot of effort* into each presentation, and at the beginning of a career it’s even more important

■ *Presentations are very important*

*What’s wrong here?*

Too much text + only text
Conflicts with you talking (more later)
Presentations Are Very Important

- You present your work and yourself

- People remember good presentations:

  ![Graph showing visual quality vs. technical content]

  You get judged by the area

  Plot suggested by Jim Bain
Presentations Are Very Important

- You present your work and yourself

- People remember good presentations:

  
  **Principle: Acknowledgment**

  Acknowledge external sources

  ![Graph showing visual quality vs. technical content](Plot suggested by Jim Bain)
An effective talk is beautiful

Parsimony

Source: hplusmagazine.com

\[ E = mc^2 \]

Elegance

Source: franzejr.files.wordpress.com

Perspective

Achieving beauty requires skill and effort
Architecture and craftsmanship matter

Which kind of talk do you want to give?
Designing a beautiful talk

• What is beauty?

• Architecture (= functionality)
  – Know what you want to transmit
  – Floor planning an effective talk
  – Know your audience (and your enemy)

• Craftsmanship (= sparkle)
Technical Content

- **Communicate:**
  - Motivation
  - Problem statement
  - Main idea
  - Main result

- **Do not (try to) communicate:**
  - Every detail of your work

- **Why?**
  - Because people cannot digest much information that quickly
  - You are lucky if they remember anything from your talk

- **How to get across?**
Floor planning a 30 minute talk

**Intro:** “hook” them fast or laptops will open
- Place the work
- Show there’s a problem
- Hint at the solution

**Background:**
- Give context
- Explain concepts
- (Some) prior work

**Present idea/solution:**
- Convince them it will work
- Key concepts only

**Experimental results:**
- Prove it worked
- Focus on implications

**Navigation aids:**
- Title, outline, conclusions

**Backup slides:**
- Extra results
- Aids for Q&A

*Too many slides = death. Cut content. Be ruthless.*
Slide titles are prime real estate

• Space is limited. Get right to the point!
• Use slide content to prove your point
  – Graphs, figures, equations, etc.
  – Span multiple slides as needed
• Punch line underscores implications
  – Tell the audience why they should care
  – Lead into the next slide
• Common pitfall: put claims in punchline
  – What was the rest of the slide doing, then?

Claims in slide titles => strong story line
Know your audience

• Conference talk?
  – Transmit “the juice” of your talk
  – Convince them to read your paper

• Job talk or potential collaborator?
  – Tailor-made “story” is key
  – Prove your work is relevant to their interests

• Keynote?
  – General audience (avoid hairy details)
  – Open their eyes to broad trends and implications
Know Your Enemy
You can’t read and listen at the same time

Every aspect of talk must reflect this one fact
What belongs in the talk slides?

Slides I show audience

Things I say

Point I want to make

Things I want to say

Material from the paper

Good slides = self-propelled talk
Designing a beautiful talk

• What is beauty?
• Architecture (= functionality)
• Craftsmanship (= sparkle)
  – Slides
  – Figures
  – Equations
  – Graphs
  – Tables
Colors
Colors
Colors: Basics

- Use color
  - Pick a few colors and stick with them (consistency)

Avoid fully saturated

Choose somewhat desaturated
Warm Colors Dominate, Cool Colors Recede

- That’s why in text *red* works better than *blue*.

- But for boxes it is the other way round.

  Hurts a bit, no?

- For areas/boxes: try desaturated bright (= pastel) colors.

- An outline in the same color, but darker, can look good.

- But also dark boxes (again, desaturated) can make sense.
The Looks (The Design)

- As important as content

- Design includes
  - Basic layout
  - Fonts
  - Colors
  - Graphics
  - Data presentation: Viewgraphs, tables

- Basic layout
  - Keep it simple (don’t clutter with logos etc.)
  - *Be consistent*
  - Black text on white background, or
  - **Bright text on dark background**
Fonts

- **Basics:**
  - Serif font: ergonomic for large text blocks (books)
  - Sans-serif: better readability for short text blocks

- **Use a sans-serif font**
  - *Powerpoint: use Calibri* (this talk)
  - Arial is less attractive
  - Arial Narrow is less attractive
  - For code Courier bold is best
  - Don't use this font for technical talks

- Use only one or two fonts and be consistent
Basic Tips (or newer)

- Use Office 2007, it’s worth it

- Use Slide Master to set basic appearance
  - View → Slide Master

- Set “Snap objects to grid:” simplifies placement
  - Home → Arrange → Align → Grid Settings

- Use ruler to align text with bullets
  - View → Ruler, then pull tab stops
  - Avoids things like
    - This is some text inside a bullet and badly aligned

- Shift-enter for line break without new bullet
Don’t just talk about it ....

- no corners red
- $x^2 + y^2 = r^2$
... show it!
Simple Examples

■ Process: Block diagram

■ System: Block diagram
Visualization in Biology

- Complex process:

  Combinatorial signaling pathways involved in maintaining mouse ESC pluripotency.

Source: Nature Reviews Molecular Cell Biology
vol. 6, no. 11, pp. 872-881, 2005
How to Present a Viewgraph: Example

- Start like this:
  - We compare the performance of Spiral and IPP
  - The x-axis shows ..., the y-axis shows
  - This means higher is better (or vice-versa)
  - For example, this datapoint means that ....

- Now you can explain more

- Then conclude

- *But this plot is rather mediocre ...*
Example I: Good Viewgraph

Mid-semester grades 18-645, spring 2008
number of people

grade

<table>
<thead>
<tr>
<th>Grade</th>
<th>Number of People</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>12</td>
</tr>
<tr>
<td>A-</td>
<td>10</td>
</tr>
<tr>
<td>B</td>
<td>8</td>
</tr>
<tr>
<td>C</td>
<td>6</td>
</tr>
<tr>
<td>D</td>
<td>4</td>
</tr>
</tbody>
</table>
Example I: Good Viewgraph

Mid-semester grades 18-645, spring 2008

number of people

left alignment gives sophisticated look
attractive font (avoid Roman, Arial)
grid lines do not compete with data
different visual “layer”
y-label horizontal: readable without spine damage
no y-axis (superfluous)

attractive color desaturated, does not blind you
shades can be attractive but don’t overuse

Principles used: Alignment, contrast, layering
Example II: Good Viewgraph

- Discrete cosine transform 2 (DCT-2)
- Performance [Gflop/s]
- Background/grid lines inverted
- Another way of layering
- Connection labels ↔ lines immediate
- Line styles to distinguish (color is much better though)
- No legend
- Generated library
- FFTW 3.2a
- Intel IPP 5.2
- Input size
- 4 8 16 32 64 128 256 1k 2k 4k 8k 16k 32k
Graphs should aid interpretation

Y-axis intercept: 0 (1 if log-scale)

Use log log-scale:
- when range spans 2+ orders of magnitude
- to highlight ratios instead of differences

Use scatterplot if x axis is numeric... especially when samples are unevenly spaced
## Which One Looks Better?

<table>
<thead>
<tr>
<th>Signal Processing Concept</th>
<th>Algebraic Concept (Coordinate Free)</th>
<th>In Coordinates</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter</td>
<td>$h \in A$ (algebra)</td>
<td>$\phi(h) \in \mathbb{C}^I \times \mathbb{C}^I$</td>
</tr>
<tr>
<td>Signal</td>
<td>$s = \sum s_i h_i \in \mathcal{M}$ ($A$-module)</td>
<td>$s = (s_i)_{i \in I} \in \mathbb{C}^I$</td>
</tr>
<tr>
<td>Filtering</td>
<td>$h \cdot s$</td>
<td>$\phi(h) \cdot s$</td>
</tr>
<tr>
<td>Impulse</td>
<td>Base vector $b_i \in \mathcal{M}$</td>
<td>$b_i = (\ldots, 0, 1, 0, \ldots)^T \in \mathbb{C}^I$</td>
</tr>
<tr>
<td>Impulse Response of $h \in A$</td>
<td>$h \cdot b_i \in \mathcal{M}$</td>
<td>$\phi(h) \cdot b_i = (\ldots, h_{-1}, h_0, h_1, \ldots)^T \in \mathbb{C}^I$</td>
</tr>
<tr>
<td>Fourier Transform</td>
<td>$\Delta : \mathcal{M} \to \bigoplus_{\omega \in \mathcal{W}} \mathcal{M}_\omega$</td>
<td>$F : \mathbb{C}^I \to \bigoplus_{\omega \in \mathcal{W}} \mathbb{C}^d_\omega$</td>
</tr>
<tr>
<td>Spectrum of Signal</td>
<td>$\Delta(s) = (s_\omega)<em>{\omega \in \mathcal{W}} = \omega \mapsto s</em>\omega$</td>
<td>$\Phi \mapsto \bigoplus_{\omega \in \mathcal{W}} \Phi_\omega$</td>
</tr>
<tr>
<td>Frequency Response of $h \in A$</td>
<td>n.a.</td>
<td>$F(s) = (s_\omega)<em>{\omega \in \mathcal{W}} = \omega \mapsto s</em>\omega$</td>
</tr>
<tr>
<td></td>
<td></td>
<td>$(\Phi_\omega(h))<em>{\omega \in \mathcal{W}} = \omega \mapsto \phi</em>\omega(h)$</td>
</tr>
</tbody>
</table>

### Easy decision, isn’t it?
Most Important Guidelines for Making Tables

- Avoid vertical lines

- Avoid “boxing up” cells, usually 3 horizontal lines are enough: above, below, and after heading (see examples in this guide)

- Avoid double horizontal lines

- Enough space between rows

- If in doubt, align left
### Example: Before and After

**Before:**

<table>
<thead>
<tr>
<th>Concept</th>
<th>Abstract</th>
<th>Realized</th>
</tr>
</thead>
<tbody>
<tr>
<td>shift operator</td>
<td>$q$</td>
<td>$T_1(x) = x$</td>
</tr>
<tr>
<td>shift operation</td>
<td>$\diamond$</td>
<td></td>
</tr>
<tr>
<td>space mark</td>
<td>$t_n$</td>
<td>$C_n$</td>
</tr>
<tr>
<td>$k$-fold shift operator</td>
<td>$T_k(q)$</td>
<td>$T_k(x)$</td>
</tr>
<tr>
<td>space shift</td>
<td>$q \diamond t_n = \frac{1}{2}(t_{n+1} + t_{n-1})$</td>
<td>$x \cdot C_n = \frac{1}{2}(C_{n+1} + C_{n-1})$</td>
</tr>
<tr>
<td>signal</td>
<td>$\sum s_n t_n$</td>
<td>$\sum s_n C_n(x)$</td>
</tr>
<tr>
<td>filter</td>
<td>$\sum h_k T_k(q)$</td>
<td>$\sum h_k T_k(x)$</td>
</tr>
</tbody>
</table>

**After:**

- The first column gets a header.
- Everything is left aligned.
- There are three horizontal lines only.
- I like the top and bottom ones bolder.
- More space between rows.
- Space to the left edge removed.
- Space to the right edge removed.
### Example Tables

#### Price of privilege

Minimum wealth required to be in: 2000, $

<table>
<thead>
<tr>
<th>Percentage</th>
<th>Top 50%</th>
<th>Top 10%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top 50%</td>
<td>2,161</td>
<td></td>
</tr>
<tr>
<td>Top 40%</td>
<td>3,517</td>
<td>61,041</td>
</tr>
<tr>
<td>Top 30%</td>
<td>6,318</td>
<td>150,145</td>
</tr>
<tr>
<td>Top 20%</td>
<td>14,169</td>
<td>514,512</td>
</tr>
</tbody>
</table>

*Source: World Institute for Development Economics Research*

#### The Economist's house-price indicators

<table>
<thead>
<tr>
<th></th>
<th>Latest</th>
<th>Q3 2006</th>
<th>1997-2006</th>
</tr>
</thead>
<tbody>
<tr>
<td>Denmark</td>
<td>23.3</td>
<td>18.7</td>
<td>115</td>
</tr>
<tr>
<td>Ireland</td>
<td>14.2</td>
<td>6.2</td>
<td>252</td>
</tr>
<tr>
<td>Canada</td>
<td>12.8</td>
<td>4.3</td>
<td>69</td>
</tr>
<tr>
<td>South Africa</td>
<td>12.7</td>
<td>20.7</td>
<td>327</td>
</tr>
<tr>
<td>France</td>
<td>12.5</td>
<td>15.5</td>
<td>127</td>
</tr>
<tr>
<td>Sweden</td>
<td>12.0</td>
<td>9.5</td>
<td>123</td>
</tr>
<tr>
<td>Belgium</td>
<td>11.8</td>
<td>20.0</td>
<td>118</td>
</tr>
<tr>
<td>Spain</td>
<td>10.8</td>
<td>13.4</td>
<td>173</td>
</tr>
<tr>
<td>New Zealand</td>
<td>9.6</td>
<td>14.9</td>
<td>94</td>
</tr>
<tr>
<td>Australia</td>
<td>9.5</td>
<td>1.7</td>
<td>132</td>
</tr>
<tr>
<td>Britain</td>
<td>9.5</td>
<td>2.7</td>
<td>192</td>
</tr>
<tr>
<td>United States</td>
<td>7.7</td>
<td>12.7</td>
<td>100</td>
</tr>
<tr>
<td>Singapore</td>
<td>7.6</td>
<td>3.3</td>
<td>na</td>
</tr>
<tr>
<td>Italy</td>
<td>6.6</td>
<td>7.3</td>
<td>88</td>
</tr>
<tr>
<td>Netherlands</td>
<td>6.2</td>
<td>5.3</td>
<td>97</td>
</tr>
<tr>
<td>China</td>
<td>5.4</td>
<td>5.5</td>
<td>na</td>
</tr>
<tr>
<td>Switzerland</td>
<td>2.0</td>
<td>0.8</td>
<td>16</td>
</tr>
<tr>
<td>Germany</td>
<td>-0.8</td>
<td>-1.3</td>
<td>-11</td>
</tr>
<tr>
<td>Hong Kong</td>
<td>-2.1</td>
<td>20.3</td>
<td>-44</td>
</tr>
<tr>
<td>Japan</td>
<td>-2.7</td>
<td>5.4</td>
<td>-32</td>
</tr>
</tbody>
</table>

*2004-2005

#### Not enough

Women as % of German newspapers:

<table>
<thead>
<tr>
<th>Source</th>
<th>Readers in 2006</th>
<th>Top editorial positions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Süddeutsche Zeitung</td>
<td>44.0</td>
<td>10.0</td>
</tr>
<tr>
<td>Frankfurter Allgemeine Zeitung</td>
<td>36.0</td>
<td>6.25</td>
</tr>
<tr>
<td>Handelsblatt</td>
<td>25.0</td>
<td>0</td>
</tr>
<tr>
<td>Die Welt</td>
<td>37.0</td>
<td>31.0</td>
</tr>
<tr>
<td>FT Deutschland</td>
<td>32.0</td>
<td>25.0</td>
</tr>
</tbody>
</table>

**Weeklies**

<table>
<thead>
<tr>
<th>Source</th>
<th>Readers in 2006</th>
<th>Top editorial positions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Der Spiegel</td>
<td>36.0</td>
<td>0</td>
</tr>
<tr>
<td>Focus</td>
<td>36.0</td>
<td>16.7</td>
</tr>
<tr>
<td>Stern</td>
<td>48.0</td>
<td>16.0</td>
</tr>
<tr>
<td>Die Zeit</td>
<td>43.0</td>
<td>16.6</td>
</tr>
<tr>
<td>Wirtschaftwoche</td>
<td>20.5</td>
<td>0</td>
</tr>
</tbody>
</table>

*Sources: Medien-Analyse ag.ma, Newspapers; The economist*
Equations can be deadly

Work sharing performance model:

\[ x(M, n) = \min\left( \frac{1}{p_{\text{max}}}, \frac{n}{\sum_{k<\phi} p_k + p_\phi(M) + \sum_{m \in M, k>\phi} p_{km}} \right) \]

Barrage of symbols and terms

No time for proper explanation
Masks big picture

Performance depends on two factors:

\[ \text{Throughput} = f\left( \frac{1}{\text{Total Work}}, \frac{1}{\text{Critical Path}} \right) \]

Improved by work sharing
Worsened by work sharing

All terms useful and understandable
Presentation highlights point

Be nice to your audience: parsimony is key
Principles for a beautiful talk

• Presenting well is *very* important
  – Only one chance to make a first impression
  – Gives you a real edge over all those bad presentations

• Understand the enemy
  – Bored audiences tune out
  – Overloaded audiences tune out
  – Excessive text/detail = overloaded and bored audience

• Parsimony:
  – Everything in the talk drives some point
  – Eliminate extraneous details
Books That Influenced This Talk

- Cliff Atkinson, *Beyond Bullet Points*, Microsoft Press, 2005
- Stephen Few, *Show Me the Numbers*, Analytics Press, 2004
Acknowledgments

• Slides with red backgrounds © Markus Püschel
  – His guides have vastly improved my talks
  – *Small guide to giving presentations*
    (http://www.ece.cmu.edu/~pueschel/teaching/guides/guide-presentations.pdf)
  – *Small guide to designing tables*
    (http://www.ece.cmu.edu/~pueschel/teaching/guides/guide-tables.pdf)
  – I have modified slightly some of his slides

• Natassa Ailamaki
  – Taught me what to (and not to) put in a talk
  – Taught me to put claims at the top of the slide

• CMU CALCM lab
  – Masters of the powerful intro
  – Patiently shredded my talks until I learned to do them right